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1  

INTRODUCTION 

 

 

Laser measurement system µLINE F1 is a two frequency laser 

interferometer intended to be used mainly in machine geometry 

measurements. Its small size and low weight simplify transportation 

and make the instrument especially useful for service applications. 

Software version for Windows 9x/NT/2k/XP and automation of 

many measurement processes make the interferometer easy to use. 

Software, compliant with ISO/DIS 230 and PN–93 M55580, enable 

making rapports and diagrams. It is possible to choose statistical 

results processing according to norms: ISO 230-2 (European), 

VDI/DGQ 3441 (German), NMTBA (USA), BSI BS 4656 Part 16 

(British) and PN-93 M55580 (Polish). 

 

Laser Measurement System µLINE F1 is highly configurable 

device although already in its basic configuration it allows 

performing the complicated measurements at highest possible 

precision. Available options will be described below in this user 

manual. 
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Very good technical parameters of the interferometer allow 

using it also in scientific laboratories, for precision positioning, for 

scaling optical and magnetic liners, etc. 

 

 

 

 

Safety considerations 

 

The Laser Interferometer µLINE F1 is a Safety Class I product 

designed and tested in accordance with international safety 

standards. It is also a Class II Laser product conforming to 

international laser safety regulations. The instrument and the 

manual should be inspected and reviewed for safety markings and 

instructions before operation. 

 

 

Warnings 

 

Although the laser measurement system µLINE F1 is design to 

be used in harsh environment, the following conditions must be 

met: 

• The laser head must not be put near strong magnetic 

fields. 
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• The head should not be unscrewed from its base and if it 

is, it may not be put on a heat sink (e.g. thick metal 

plate). 

• The head must not be thrown or dropped. 

• Keep the optical components clean and avoid scratching 

them. 

• When the optics is dusted, clean it with pure alcohol. 

• Do not use the system beyond its work conditions. 
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2  

PRINCIPLES OF OPERATION 

 

 

 

The rules of laser displacement measurements 

Displacement measurements with the use of a laser 

interferometer allow obtaining the accuracy of an displacement 

measurements of 0.4 ppm in air and 0.02 ppm in vacuum. The 

interferometer was first built by A.A. Michelson in 1881. The 

simplified schematic of the interferometer is shown on fig. 2.1. 

Coherent light beam falls on a semi-transparent mirror. This 

mirror splits the light into two beams. The first goes to the reference 

arm and reflects from the reflector Z1; the second goes to the 

measurement arm and reflects form the reflector Z2.  The reflected 

beams meet again on the detector. Because these beams come from 

the same, coherent, source, they will interfere. When the moving 

reflector is being displaced, the frequency of the reflected beam in 

the measurement arm changes. The detector counts the frequency 

difference between reflected beams - fD (see fig. 2.1). The measured 

value of the displacement is calculated according to  

 

22
*

λλ
∗== NfL D  (1) 
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                   Where:  N – number of pulses, 

                                λ - light wavelength. 

 

FIG.2.1. THE MICHELSON INTERFEROMETER.  

 

The construction of real interferometers 

The main disadvantage of Michelson interferometer results 

from the fact that the detector cannot determine, whether fD is 

negative or positive thus, from the measurements the displacement 

of the moving reflector without the sign is obtained. Currently there 

are widely used two methods that allow getting also the direction of 

the movement. Depending on the number of light frequencies 
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(wavelengths) used in the interferometer, the first is called homodyne 

(one frequency) and the second heterodyne (two frequencies) 

method.  

In the homodyne method, shown on figure 2.2, as a coherent 

source of light a linearly polarized laser is used. If it is two-mode 

laser (i.e. it generates two wavelengths) than one mode must be cut 

off with the use of a properly set polarizer. The polarising splitter 

splits the light beam from the laser into two beams polarized 

vertically (90o) and horizontally (0o). The former is directed to the 

measurement arm and the latter to the reference one. The frequency 

of the beam in the measurement arm changes with the movement of 

the moving reflector. The polarization of the reflected beams is 

changed to circular with the use of a λ/4 waveplate. After 0° and 45° 

polarizers, two signals shifted in phase are obtained. The phase shift 

is +90o when the measurement arm moves to and -90o when it 

moves from the laser.  
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FIG.2.2. THE BLOCK DIAGRAM OF AN INTERFEROMETER WORKING 

ACCORDING TO THE HOMODYNE METHOD 

 

In the heterodyne method, shown on figure 2.3, two laser 

frequencies are used. Therefore a two-frequency laser is needed, e.g. 

a Zeeman laser. A two-mode laser is not suitable for the heterodyne 

method interferometer, because the difference between f1 and f2 is 

usually too high for an electronic counter. The output beam of a 

Zeeman laser consists of two circularly polarized beams, one 

polarized leftward and the second rightward. A λ/4 waveplate 
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changes circular polarization to linear. The main difference between 

two described methods is that in the heterodyne one the beam 

frequency in reference arm differs from the beam frequency in the 

measuring arm. A detection path is also different – subtracting 

differential frequencies of reference and measuring arms does the 

measurement. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FIG.2.3. THE BLOCK DIAGRAM OF AN INTERFEROMETER, WORKING 

ACCORDING TO THE HETERODYNE METHOD 
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The heterodyne method gives correct results only when fD 

does not exceed the difference between the laser frequencies, i.e.: f2 – 

f1. In reality, that difference, resulting from the Zeeman effect, is 

about 1MHz. This limits the maximum available velocity of 

measuring arm, in one direction, to 0.3 m/s. The next disadvantage 

of the heterodyne method is, that two frequencies must be used for 

measurements, while in the homodyne method the second may be 

used for measuring e.g. a second axis.   

 

The influence of the outside conditions on the 

measurement accuracy 

 

According to equation (1) an interferometer’s unit of measure 

in length measurement is laser’s wavelength. From definition 

 

f

v
=λ   (2) 

 

a wavelength depends on laser’s frequency f and the speed of 

light v in the measuring path. If the measurement is done in 

vacuum, than ν = c = 3*108 m/s. The speed of light in a medium 

other than vacuum (e.g. air, water) is lower and is described as  

 

n

c
v =    (3) 

                 Where: n – a refraction coefficient. 
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Normally the refraction coefficient n is a complex variable or 

even a tensor, but for less accurate calculations it is simplified to a 

constant. The air coefficient depends mostly on the pressure P, 

temperature T and humidity H. The dependence nT,P,H, for the air 

was empirically determined by Edien and is described as 

 

n
T

TP
Pn HPT ∆+

+
−+

=−
−

−

*003661,01

)*00997,0613,0(**101
*10*8775,21

6
7

,,  (4) 

TeHn *057627,09 **10*033,3 −−=∆  (5) 

 

From the above equations one may obtain the refraction 

coefficient dependences on T, P and H in usual conditions (T=293K, 

P=1000hPa, H=50%): 






−=
∂
∂ −

KT

n 1
10*93,0 6  









+=

∂

∂ −

hPaP

n 1
10*27,0 6  






−=
∂
∂ −

%

1
10*96,0 8

H

n
 

It is worth to notice that the most critical parameter is the 

temperature, because its change influences the coefficient n more 

than changes in the pressure and much more than changes in the 

humidity. 

 

 

  

The accuracy of laser interferometers 
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Errors caused by the environment  

 

The most impotent source of errors in machine geometry 

measurements is the temperature (or more exactly, the change of the 

temperature) of the measured machine. For example, if the 

machine’s base is made of steel, than the base’s length increases 

11.7�m when its temperature changes 1K. It shows how important 

it is for very precise measurements to measure the temperature of 

the controlled part of the machine and to use it in readout 

corrections. This is not a simple task for a few reasons, but the most 

important one is that, than when the machine operates, there are 

temperature gradients on it. That means that more than one 

temperature sensor is needed and that the more sensors are used the 

better accuracy can be achieved.  Moreover the shape of the 

measured part of the machine may “absorb” a part of the expansion 

of the material or the part may be built of materials of different 

expandability. 

As was mentioned in the previous chapter, the temperature 

influences the accuracy also as it changes the refraction coefficient of 

the medium the measurements are made in (usually it is air, but 

may be e.g. water). An Edlen equation was presented, showing how 

the refraction coefficient of the air changes with the change of the air 

temperature, pressure and humidity. The errors caused by the 

change of the wavelength are less important than the mentioned 

above, but they cannot be abandoned. Roughly, a 1ppm error (i.e. 
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1µm/m) is caused by: the air temperature change of o 1K, the air 

pressure change of 4hPa and the air humidity change of 30%. 

 

Dead path error 

 

A dead path error is an error associated with the change in 

environmental parameters during a measurement. This error occurs 

when some part of the light path (a dead path) is not included in the 

temperature (both air and base), pressure and humidity 

compensation.  

The dead path of the light path is a distance between the optical 

interferometer and the base (or the null point) of the measuring 

position (L1 on figure 2.4). Let the position of the interferometer and 

the retro-reflector do not change. When there is a change in the air 

temperature, pressure or humidity, than the wavelength changes on 

the whole path length (L1 + L2). The path length changes also when 

the temperature of the base changes. But the correction system will 

use the correct wavelength only on the length L2 and will correct 

only this length. The correction will not be made on a dead path L1. 

In this way, the laser system will “move” the base point.  

A dead path error is the more severe the greater is the distance 

between the interferometer and the base point. This error is 

especially important in laser interferometers where the 

interferometer is build-up in a common casing with a laser head, 

because it is than very difficult to reduce a dead path. 
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FIG.2.4. AN ILLUSTRATION OF A DEAD PATH ERROR 

 

 

Cosine error 

 

If the laser beam is not parallel to a measured axis of a 

machine (i.e. the optical path is not properly adjusted) than a 

difference between the real distance and the measured distance 

occurs. This error of unalignment is known as a cosine error, 

because its magnitude depends on the angle between the laser beam 

and the axis of the machine (fig. 2.5). 

If, as a reflector a flat mirror is used, than the beam must be 

perpendicular to it. If the machine changes its position form point A 
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to point B, than the beam stays perpendicular to the mirror, but 

moves on its surface. The distance measured by the laser 

interferometer LLMS, will be smaller, than the real distance LM, 

according to  

 

LLMS = LM * cosΘ (6) 

 

The above equation is valid also when as a reflector a corn 

cube is used. 

 

FIG.2.5. THE BEAM UNALIGNMENT AS A CAUSE OF A COSINE ERROR 

 

The only method of eliminating the cosine error is a proper 

laser beam alignment done before a measurement. 
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Abbe error 

 

An Abbe error occurs when, during measurements, the 

measured part does not move perfectly straight and there appear 

angular movements, which cause sloping of the retro-reflector. The 

sloping of the reflector is the greater the longer is the distance 

between the axis of the measurement and the axis of movement. 

This distance is called An Abbe offset. Only the movements in the axis 

of the measurement are important (see fig. 2.6). An Abbe error may 

be avoided only when there are no angular movements of the retro-

reflector in the axis of the measurements. 

 

FIG.2.6.  AN ILLUSTRATION OF AN ABBE ERROR 

 

 

 

Laser stability error 

 

As was already mentioned, in laser measurements the laser 

wavelength instability changes directly the readout from the 
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interferometer, e.g. a relative instability of the laser in the range of 

1ppm (10-6), causes an error of 1µm on every 1m of a measured 

distance. Therefore the laser instability error is important mainly in 

measurements in vacuum (where a refraction coefficient is constant) 

and when a low stability laser is used (e.g. a semiconductor laser). 

The stability of usually used in laser measurement systems, HeNe 

gas lasers is 0.02 ppm, so the stability error may be neglected. 

 

 

Other errors 

 

In some conditions, a noticeable error may be caused by the 

electronic part of the interferometer. As the electronics is used 

mainly for counting, the errors may be associated either with 

miscounting (some pulses are not counted) or with miscalculating 

(the calculations are made with finite precision).  

 

 

A summary of laser measurement system errors 

In order to show which of the errors influence the accuracy of 

a laser measurement system the most, an exemplary calculation of 

errors on a 1m long steel machine is shown on figures 2.7 and 2.8. 

Different scales of the charts should be taken into account.  
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FIG.2.7.  A CALCULATION OF ERRORS FOR A LASER MEASUREMENT 

SYSTEM WITHOUT THE COMPENSATION OF THE ENVIRONMENT 

 

FIG.2.8.  A CALCULATION OF ERRORS FOR A LASER MEASUREMENT 

SYSTEM WITH THE COMPENSATION OF THE ENVIRONMENT
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3  

PREPARATIONS 

 

 

 

 

 To start the measurements using the Laser Interferometer 

µLINE F1, software "LSP software" should be installed on HD of a 

PC computer. The hardware requirements are:  

- Windows XP/Vista/7 system, 

- CR-ROM 

- Pentium processor, 1 GHz or better 

- SVGA graphic card making possible working with 

resolution 800x600 

- USB 2.0 

- Bluetooth 2.0 for µLINE F1 Wireless – BT version 

 

Software installation 

 

The software is located on the CD that comes with the measurement 

system. Once inserted into your computer, view the contents of the CD and find 

a file named LSP_Install, and then run it. The installation process of the 

application and the necessary drivers should start automatically.  
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Fig. 3.1. Icon of the setup application. 

 

After running the setup file, in following windows the program asks 

about the necessary parameters to correctly install the software. To let µLINE F1 

to work correctly, the following components must be installed: 

 − LSP30-3D application 

 − directory of the languages Languages 

 − Hex directory with the firmware for the laser measurement system 

 − directory FTDI Driver for USB 

 − Documents folder with the manual and other documents (depending on 

system version) 

 − database BDE (Borland Database Environments) 

 

 The window shown in the figure 3.2 appears first during installation. It 

allows choosing the installation language.  

 

 

Fig.3.2. Installation language setup window. 
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Fig.3.3. Welcome window. 

 

Fig.3.4. User Information window 
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Fig.3.5. Program destination folder window. 

 

 

Fig.3.6. Window appearing when the folder name does not exsist in the system. 
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Fig.3.7. Menu Start name choice window 

 

Fig.3.8. Desktop icon setup window 
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Fig.3.9. Window with installation information 

 

Fig.3.10. Installation window during data copy operation 
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Fig.3.11. BDE (Borland Database Environment) destination folder window 

 

 

Fig.3.12. Window where “Yes” must be chosen 

 

 

Fig.3.13. FTDI driver load  
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Fig.3.14. Installation summary window 

 

In most cases, the installation is semi-automatic requiring only 

confirmation by the Enter key. 

 

 After installation of the first time on the computer, the application should 

not be run right away. First the drivers should be allowed to find the laser 

measurement system. To this end, the system must be connected by a USB cable 

to your PC, then wait until the system finds the device and Widnows matches 

for the drivers. 

 

 

 

Fig.3.15. Message appearing after finding the new USB device. 
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Fig.3.16. Message appearing after matching the driver with Liner HPI device. 

 

To run the application, see the Windows Start Menu Programs tab, and 

then find the folder µLINE F1 (assuming that the installation settings were not 

changed) and run µLINE F1. Running applications can also be made from the 

desktop, if this option was chosen during installation. 

Fig.3.17. Icon of µLINE F1 application. 

 

In order to uninstall the µLINE F1 application please choose Uninstall 

µLINE F1 from Menu Start. 

Fig.3.18.  Icon of µLINE F1 deinstallation application 
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Elements of the Laser System 

 

The number of elements of the system depends on desired 

types of measurements. To the standard set (for linear 

measurements) belong: 

 

1 pcs Laser head 

 

1 pcs Power supply 

 

1 pcs Tripod stand  

1 pcs Linear retro-

reflector RL1 

 

1 pcs Linear 

interferometer 

IL1 
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3 pcs Basis 

temperature 

sensor 

 

1 pcs Air 

temperature 

sensor 

 

1 pcs Wireless strobe 

 

1 pcs Magnetic 

holder UM1 

 

1 pcs Magnetic 

holder UM2 
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In the figure 3.19 there is shown a suitcase for transportation and 

storing of the interferometer system is shown. 

. 

Additional elements for angular measurements are: 

1. 1 x Angular interferometer IK1 

2. 1 x Angular retro-reflector RK1 

3. 2 x Beam directing mirror ZK1 

4. 1 x Rotary table SO1 

 

FIG.3.19. THE SUITCASE FOR TRANSPORTATION AND STORING OF THE 

INTERFEROMETER SYSTEM 
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Preparing the interferometer to work 

 

The Laser Interferometer µLINE F1 is supplied from 

autonomous  24VDC/5A power supply. Communication with a PC 

computer is performed by USB interface or by a Bluetooth interface. 

USB connection is faster thus it gives more possibilities in some 

measurements (i.e. Vibration).  

 

Before starting the measurements the laser head –"Laser 

Interferometer"(1) should be placed on the Tripod stand (3) and 

connected to the power supply connector on the back of the laser 

head. The laser head can be also placed directly on the machine 

because of the strong magnets placed in the laser head base. 

If the USB connection is to be used then the USB cable (10) 

should be connected to the male socket on the back panel of the 

Laser Head (fig. 3.21). The second end of the cable ought to be 

plugged into the USB socket of a PC computer. For Bluetooth 

connection no more cables are necessary. 

Through the Extension Connector it is possible to drive many 

peripherals directly from the laser head. This give huge possibilities 

of customization of the usage of the laser interferometer – e.g. in 

emulation of glass scales, driving stepping motors, dynamic 

measurements, etc. Standard connector pinout is described in 

Technical Data at the end of the instruction.  
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FIG.3.21. CONNECTIONS OF THE µLINE F1.  

 

In the wireless versions of the µLINE F1 no sensor cables 

attachment is necessary. Air and base temperature sensors are 

wireless. They are  maintenance free – they do not require neither 

switching on nor charging. They “wake up” after the power supply 

unit is switched on and go into power down mode when the supply 

unit is switched off.  

Wireless Strobe is used to control the moment of measurement 

either by hand or automatically during dynamic positioning (see 

appropriate chapter). 

The shelf life of the sensors is more than 30000 hours. The 

working time is 10000 hours. Under the cap there is hidden a 1/2AA 

Power Button 

Power Connector 

Extension Connector 

USB Connector 
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3.6V lithium battery (number 14250) which can be replaced when 

the battery strength monitor on Display screen (see below in this 

Chapter) shows that it is depleted.  
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Powering the system on 

 

Starting hardware 

   

The µLine F1 has only one soft-switch on the top of the laser 

head. Starting the laser is possible by pressing the Power Button for 3  

seconds (see figure 3.21) or from the LSP software by clicking on the 

bottom bar of the screen in “Laser” text (see fig. 3.24). 

 

 

FIG.3.24.  POWER SWITCH OF THE µLINE F1 

 

Starting software 

 

When the software starts a splash screen appears (figure 3.24). 

Pressing F5 on the PC keyboard or the button marked Simulator 

causes the software to switch into simulation mode – connection to 
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an µLINE F1 device is emulated even if there is a real device 

connected to the computer! 

 

 

FIG.3.25.  SPLASH SCREEN 

 

After the splash screen a connection screen appears (figure 

3.25) where the connection trials are shown. In the right bottom part 

there shown the interface over which the software is actually trying 

to obtain connection (see a red circle on the figure 3.24). After 

software installation, by default, the first trials are made over USB 

interface. When there is successful connection made over other 

interfaces then the “successful” interface is taken as a first choice in 

next runs. 
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FIG.3.26.  CONNECTION SCREEN 

 

 

FIG.3.27. MAIN MENU 

 

After the connection screen there appears the Main Menu 

appears as shown on the figure 3.27. There are two rows of buttons. 
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Button Display opens the window with basic control of the laser 

operation. It is described in details later in this Chapter. Button 

Configuration opens configuration window. Pressing Exit button 

closes the application. 

Other buttons open measurement screens. All options are 

described in details in following Chapters. Because of abundance of 

measurement types offered by the µLINE F1, some of the options 

are not visible and can be reached by using the buttons with arrows 

in the second row.   

 

Connection problems troubleshooting 

 

If the program is started before the Power Supply is turned on 

or the Power Supply is not connected properly to the computer, on 

the monitor an error window will appear (fig. 3.4). To get rid of this 

error quit the program, check the connection and/or the supply of 

the Interferometer (the POWER diode should be on). 

If the interferometer is not connected to the computer an error 

window with “Could not open COM port. Check COM port settings” 

line will appear. Please check the connection between the computer 

and the power supply and choose Configuration option from the 

main menu. 
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FIG.3.28. ERROR THAT MAY OCCUR DURING SOFTWARE LOADING 

 

In the option Configuration (Fig. 3.29) the user can configure 

the behavior of the µLINE F1 during measurements and the 

appearance of the LSP Software. For example the language of the 

program can be changed - after installation the program opens in 

the language of the installed Windows system. In other panels of 

mentioned window the user can configure many parameters of all 

types of measurements available with the system. These panel can 

be also reached from other parts of the program as it will be 

described later in this document.  

In the Interface panel the user can force the software to try 

connecting with the laser over chosen interface. In order to do this 

the user should choose the right communication interface (USB, 

WiFi, Bluetooth or Simulator) and press Reconnect. After a while an 

appropriate message will be displayed (with communication success 

or failure). 
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FIG. 3.29. CONFIGURATION WINDOW – INTERFACE PANEL 
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Getting basic information from the system. 

 

After proper software loading the option Display in the Main 

Menu ought to be chosen. The window shown on the figure 3.30 

should appear. The laser system will be heated up. If the output 

beam of the laser is properly redirected to the laser head (e.g. with 

the use of the retroreflector RL1) the Beam Strength – the green 

indicator on the screen – will appear and disappear. The speed of 

changes will become smaller due to the increase in the temperature 

of the laser system cover. During the heating up time the measuring 

system is ready for the alignment of the optical arrangement of the 

laser path (see chapter 4). 

 

 

FIG.3.30. DISPLAY WINDOW 

 

On the Display screen there ia a status bar and four panels:  
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- Panel containing the digital result of the measurement 

(figure 3.31), the measuring signal level indicator and the 

buttons for changing the number of displayed Digits and 

for changing Units. Quantity of significant digits on display 

may be changed with the use of buttons ↑↑↑↑ ↓↓↓↓, pressing 

button with an inscription Change changes measurement 

unit on the display. In the upper left corner there is an icon 

making link to Microsoft Excel (if installed). Running this 

link allows to register measurement in Excel cells by each 

STROBE button press. 

 

 

FIG.3.31. PANEL WITH MAIN DISPLAY 

 

- Panel Environment (figure 3.32) where measured data 

obtained from the Environmental Compensation Unit - 

(ECU)  are shown. On the screen there are shown: 

temperature, pressure and humidity of the atmosphere 

(Humidity, Pressure and Air Temp.) and temperatures 

measured by three base temperature sensors (Average temp., 

T1, T2 and T3). Average temperature of the base measured 

by three sensors is also presented. There two types of this 
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panel in dependence on the µLINE F1 version. There is 

different panel for Wireless and Wired version. The main 

difference in Wireless version is the presence of battery and 

signal strength monitors for each sensor. 

 

                

FIG.3.32. ENVIRONEMNTAL PANELS: WIRELESS (LEFT), WIRED (RIGHT) 

 

- Panel Measurement (figure 3.33) contains basic information 

about conducted measurement. With the left button the 

type of measurement can be changed. The right is used for 

choosing measuring axis. At every change of measuring 

option (i.e. distance, speed, angle, straightness) and/or 

change of measuring axis (i.e. X, Y, Z) a drawing suggesting 

the arrangement of the optical elements appears on the 

screen. Clicking with left mouse key in the area of the 

drawing invokes help on a theme of the optical 

arrangement alignment. Panel Measurement can also 

contains an option Adjustment. This option is very helpful 

in optical path alignment process (see chapter 4). 

-  
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FIG.3.33. MEASUREMENT PANEL 

 

- Panel Parameters (figure 3.34) contains a few options. 

Option Sign allows choosing whether enlarging distances 

between the retro-reflector and the interferometer gives 

positive (default “+”) or negative result on the display. In 

the option Material one can choose the material from which 

a basis of a machine is made of. The value of the thermal 

expandability coefficient of the basis is used for calculations 

of the real shift value (i.e. measured value referred to the 

temperature of 20°C). Option User makes it possible to 

enter any value of the thermal expandability coefficient. In 

the panel Resolution one can change between high (10nm) 

and low (100nm) system resolution. In higher resolution 

accepted movement velocity is strictly limited (see 

Technical data chapter for details). In the panel 

Environment the data from Environmental Compensation 

Unit - (ECU) may be controlled. From console of the 

computer one can switch off the data coming from 
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Environmental Compensation Unit - (ECU)  and insert the 

parameters of the atmosphere by hand.  

 

 

FIG.3.34. PARAMETERS PANEL 

 

• Status Bar (figure 3.35) shows the state of the laser 

head and the state of the measurements. There are 

four fields: Connection, Laser, Signal and Velocity 

signalizing the state of each of the elements. In proper 

operation they should all be green. In table 3.1 there 

are shown the possible states of the fields. 

•  

Field name Field state State description Required action 

Connection Red No connection to laser Click on the field to open 

Configuration window. 

Restart the connection 

Green Laser head is connected to 

the computer properly 

No action necessary 

Laser Red Laser head off Click on the field to switch 

the laser on 

Red – 

blinking 

Laser head on but not 

ready 

Wait for the laser to become 

ready 

Yellow Laser head near unstable Finish performed 
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region.  measurements and click on 

the field to allow the head 

to find new working point 

Green Laser head works well No action necessary 

Signal Red – 

blinking 

Beam strength too week. Using beam indicator set 

optical components to 

obtain satisfactorily beam 

strength, then click on the 

field to reset the error  

Green Beam strength fine No action necessary 

Velocity Red – 

blinking 

Velocity of the registered 

movement too high 

Click on the field to reset 

the error 

Green Velocity of the registered 

movement in range 

No action necessary 

TAB.3.1. STATUS BAR STATES 

 

When measurements are executed with automatic 

compensation of the atmosphere parameters and the compensation 

of the basis temperatures one should: 

- place the air temperature and humidity sensors THS on the 

machine in the vicinity of the laser beam. 

-  place the sensors of the basis temperature along the 

measured axis on the machine basis 

Measurement executed without automatic compensation are 

referred to normal conditions: temperature 20 °C, pressure 1013.25 

hPa, humidity 50 %. The reference temperature for material 

expandability compensation can be modified in Configuration-

>Meteo panel (see figure 3.36). 
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FIG. 3.36. CONFIGURATION WINDOW – METEO PANEL 
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Recording mode 

 

The long term changes of the length of machine axes under 

changes of temperature condition may give the information about 

thermal properties of the machine. This kind of measurements 

called “Recording mode” may be chosen by pressing RECORD 

button on the Display screen. This switches the system into the 

mode of the data recorder. The time interval of the records could be 

programmed from the computer by setting a required value.  

 

FIG.3.36. RECORDING DATA MODE WINDOW 
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Pressing “End Recording” finishes the data recording. The results 

can be saved with the choice of “Save to file”. In fig. 3.36 the 

example of Data Record is presented. 
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Flat mirror measurements - option 

 

       The flat mirror measurements permits the measurements of 

displacement, velocity, positioning and vibrations of a flat surface. 

The surface should have mirror quality (surface flatness λ/8) and 

the reflection coefficient not less 50%. The aluminium, gold or 

dielectric mirror mounted to the moving part is suggested. There are 

two possible configuration: double pass setup Fig. 3.36 and single 

pass setup 3.37. The resolution of double pass setup is two time 

bigger then one pass. The setup consist from the laser head, the flat 

mirror interferometer FMI and the flat mirror.  One have to chose 

the single/double pass option on the screen in display mode to have 

correct result of measurement.  

 

 

FIG. 3.37.  DOUBLE PASS FLAT MIRROR INTERFREOMETER 
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FIG. 3.38.  SINGLE PASS FLAT MIRROR INTERFREOMETER 
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4  

BEAM ALIGNMENT 

 

 

 

 

 

 

 

The µLine F1 provide unique function - Laser Head which is a 

very useful tools for the laser beam alignment. Beam alignment is a 

process in which the user, with the use of certain mechanical 

arrangements, makes the direction of the laser beam parallel to the 

direction of the movement in a measured axis. If the beam is not 

correctly aligned an effect like the one shown on Fig.4.1 may 

happen, i.e. the position of the beam returning on the detector in the 

laser head from the moving retroreflector may vary with the 

position of the retroreflector resulting in a cosine error (see chapter 

2) and/or misalignment of the optical path (no Beam Strength). 

 

The alignment of the optical path is the most difficult and laborious part 

of the whole measurement process. Be very careful reading this chapter!  
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 FIG.4.1. ILLUSTRATION OF BEAM ALIGNMENT 

 

The alignment of the optical set up should be conducted in 

option Display. It can be done during laser head heating. Final 

check should be made when the system is ready to work. 

The Laser Head should be firmly attached to the tripod. The 

tripod should not touch a machine as it may cause vibration of the 

laser head and the optical path. Turn special attention, not to move 

the legs of the tripod during the measurements, because it will cause 

shift of elements of the optical path and the necessity of repetition of 

the alignment process.  
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FIG. 4.1 ILUSTRATION OF THE FUNCTION LASER HEAD 

 

The arrangement of the tripod helps to adjust the optical path. 

Inspection of the level of arrangement can be made using level 

fastened on the tripod. The angular position of the laser head is set 

using the function Laser Head. The tripod must be levelled, and 

after that with the function Laser Head the position of  laser head 

must be set according the angle of measuring path. In the most 

application the laser head is levelled. In special cases, when the 

measuring path is sloped to the level, the angle of slope must be set. 

The angle of rotation of laser head must be set to zero degree (90  

degree in some configuration). The diaphragm of the laser beam on 
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the front panel of the laser head helps in the process of alignment. 

The diaphragm can be placed in two positions:  

- " Alignment" – the laser beam goes out through opening in 

the diaphragm about 2 mm diameter,  

- " Measurement" from the laser head goes out beam about 8 

mm diameter, 

 

 

FIG.4.1. DIAPHRAGM POSITIONS. A) MEASUREMENT, B) ALIGNMENT 

 

During transportation or when system is not used, correct 

position of diaphragm is alignment position. In this position optics 

is safe from getting dirty, covering with dust and accidental damage 

during transportation.  
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Beam alignment process 

 

1. In the option Display in the PC program choose type of 

measurement, which will be done and axis along of which 

measurements will be carried. On the screen will appear a drawing 

showing recommended arrangement of measuring elements at the 

chosen type of measurement (Fig. 3.6).  

2 Linear interferometer IL1 and linear retro-reflector RL1 

should be mounted on magnetic holders UM1, UM2. Regulating 

elements (see Fig. 4.2a, b, c) of the laser head should be placed in 

central positions, to assure maximum range of regulation.  
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FIG.4.2.  THE LASER HEAD ALIGNMENT ELEMENTS 

 

3. Choose which from the optical elements will be moved 

(retro-reflector RL1 or interferometer IL1) and attach both with 

magnetic holders: one to a moving element of the machine, second 

to an element in relation to which displacement will be measured 

(for example: the retro-reflector may be fasten to a moving element, 

and the interferometer to a motionless table). Remember, that relative 

Z Aligment 
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linear displacement between the retro-reflector and the interferometer is 

measured. 

Attention! It is inadmissible to place one of optical elements (i.e. 

RL1 or IL1) outside the machine on an additional stand – the system 

measures then also displacements of the machine in relation to the 

stand!!!).  

4. The moving element of investigated axis should be moved 

as close as possible to the position of the laser head and the tripod.   

5. Place the interferometer optics IL1 and the retro-reflector 

RL1 on the axis of movement. If the axis of movement is horizontal 

check the level indicators (Fig. 4.3) on the laser head and the 

interferometer. In both cases the blob should be inside the inner 

circle. 

Attach the retro-reflector RL1 to the interferometer IL1 (there 

is a special socket for this purpose in IL1) – see fig.4.3. 

  

 

FIG.4.3. START POSITION OF ALIGNMENT 

 

Level 
indicator 
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6. Move the moving element of the machine together with the 

attached optical element to the opposite, extreme position. 

Diaphragms on IL1 and RL1 and of laser head place in position – 

“Alignment” (Fig. 4.4a).  

 

 

FIG.4.4. ALIGNMENT POSITION (A) AND WORK POSITION (B) 

 

7. Regulate the tripod height and level of the laser head by 

means of a sphere joint. The laser beam has to fall on the upper hole 

A B 
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of the interferometer diaphragm and after passing by the hole must 

be found within diaphragm area of the retro-reflector. The laser 

head should be placed horizontally (for horizontal axes) – control it 

on the level indicator.  

8. Using regulating elements of the laser head (Fig. 4.2) find a 

position in which laser beam passes through both upper holes in the 

diaphragms placed on the interferometer and the retro-reflector. The 

spot position on the diaphragm of the interferometer (the 

interferometer is placed closer to the laser head) – should be 

regulated with X stage and up-down translation stage Z and up-

down translation of the tripod. The spot position on the retro-

reflector diaphragm (the retro-reflector is far from laser 

interferometer) – should be regulated with “α” angle alignment in 

vertical and “β” angle alignment in horizontal line. 

9. Switch the diaphragms on RL1 in a position “Work”.  

10. Using the regulating elements of the laser head adjust the 

position of laser beams on the diaphragm of laser head. Two return 

beams should exactly cover each other on the entrance hole on the 

front panel of the laser head during the whole movement range. If 

this is necessary gently correct the position of the IL1. Shift the 

diaphragm on the laser head to the position “Work”. The level of the 

measuring signal (the green indicator on the screen of the computer) 

should have value not less than 80 % during translocation of the 

moving element along the whole path.  

12. Reset displayed position using “Reset” button on the 

display. System is ready to work.  
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Attention! Remember, that the position when the interferometer 

touches the retro-reflector can serve only to adjust. Be sure that 

during measurements in extreme nearest measuring position the 

retro-reflector does not touch the interferometer, because it can be a 

source of measuring errors.  
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5  

MEASUREMENTS - POSITIONING 

 

 

 

 

 

General Description 

 

The linear positioning measurement is the most advanced 

option of linear measurements. It is the most common form of laser 

measurements performed on machines. The system measures linear 

positioning accuracy, repeatability and backlash by comparing the 

position to which the machine moves (i.e. the position displayed on 

the machine’s readout) with the true position measured by the 

interferometer. 

The µLINE F1 device offers a unique feature of simultaneous 

measurement of positioning and straightness in horizontal and 

vertical planes. This 3D feature simplifies and significantly speeds 

the process of machine geometry testing. 

Measurement Setup 

 

For positioning measurements linear optics should be used. 

Necessary components are (see also figures 5.1 to 5.4): 
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- Laser head  

- Power supply  

- Linear interferometer IL1 

- Linear retro-reflector RL1 

- Air temperature sensor 

- At least 1 Basis temperature sensor  

 

 

Optional elements are: 

- USB cable 

- Manual Strobe  

- Magnetic holder UM1 

- Tripod stand 

 

Positioning measurements require optical elements IL1 and RL1 

to be aligned along laser beam as shown on the figure 5.1. Either of 

the elements can be moved.  

Performing positioning measurements one has to be aware of 

the Abbe, Dead Path and Cosine errors, as they are described in 

Chapter 2. The usage of the air temperature sensor and at least one 

base temperature sensor (T1 or T2 or T3) is absolutely necessary! 

More basis temperature sensors can be used on long measurement 

axes, especially where a temperature gradient is suspected. 
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 FIG.5.1 OPTICAL PATH  SET UP FOR POSITIONING MEASUREMENTS- 

SCHEMATIC 

 

Positioning measurements can be performed not only along the 

laser beam (as shown on figures 5.1 and 5.2) but also in directions 

perpendicular to the laser beam. These configurations are shown on 

figures 5.3 and 5.4. In those two configurations only the retro-

reflector RL1 can be moved. 

 

 

FIG.5.2 OPTICAL PATH  SET UP FOR POSITIONING MEASUREMENTS IN X 

AXIS 
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FIG.5.3. OPTICAL PATH SET UP FOR POSITIONING MEASUREMENTS IN Y 

AXIS 

 



MEASUREMENTS - POSITIONING 

 

5-5  www.statuspro.com    

FIG.5.4. OPTICAL PATH SET UP FOR POSITIONING MEASUREMENTS IN Z 

AXIS 

 

 

Software description 

 

In order to start Positioning measurements in the Main Menu 

the Positioning button should be pressed. On the screen there 

should appear a window Linear positioning as shown on the fig. 

5.5 

  

 

FIG.5.5 LINEAR POSITIONING WINDOW 
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Pull down menu - File 

 

The upper menu of this window consists of options: File, Edit, 

Measurement, View, Help. In the option File (figure 5.6) there can be 

found instructions for reading measured data from a file, saving the 

data to a file, printing measurements results or exporting them to a 

file. 

 

 

FIG.5.6. POSITIONING PULL-DOWN MENU FILE  

 

Other important options available in the File menu are options 

for generating CNC path and preparing compensation table. 

 

CNC path generation 
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CNC path generation options allows automatic preparation, 

by the  µLINE F1 software, the G-code program compatible with 

most CNC steerings. The options of the path generation are set in 

the separate window as shown on the figure 5.7.  

In the upper part of the window the machine movement 

parameters can be set. In the lower part the generated program can 

be viewed end edited. The results can be saved to a text file or 

previewed and printed. 

    

FIG.5.7. CNC PATH GENERATION WINDOW  

 

Compensation table preparation 
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Compensation table preparation (figure 5.8) is an option used 

after measurement finish (before start it is not enabled). From the 

end results the software calculates the errors and suggests the 

machine control the compensation values. Because different 

machine controls require different format of compensation file, thus 

in the compensation table preparation window the right data format 

has to be set together with options required in the chosen format. 

 

FIG.5.8. COMPENSATION TABLE PREPARATION WINDOW  

 

Pull down menu - Edit 

 

In the pull-down menu option Edit (fig. 5.9) there are options 

for setting measured machine data (Fig 5.10), defining machine error 
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limits  (fig. 5.11), previewing obtained positioning results, editing 

positioning points (when option Target Points from List from menu 

Measurement is active) and changing overall positioning 

configuration.  

 

FIG.5.9. POSITIONING PULL-DOWN MENU EDIT  

 

 

FIG.5.10 MACHINE DATAWINDOW 
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Machine error limits 

 

 

FIG.5.11. MACHINE ERROR LIMITS WINDOW 

 

In the Edit option the user can setup allowable error limits of 

the machine for different norms (option Machine error limits - 

Fig. 5.11). The results of the whole linear positioning measurements 

are compared with this limits (see Fig. 5.12). This option is especially 

useful when there are checked many machines of the same type and 

the same requirements on their accuracy. 
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FIG.5.12. MACHINE ERROR LIMITS COMPARATION PANEL 

 

Positioning points generation 

 

When option Target Points from List from menu 

Measurement is active then the program expects the measured 

machine to stop in points defined in the Positioning points window 

as shown on the figure 5.13. Points can be entered manually or can 

be generated from the input parameters: start position (can be 

negative), distance (must be positive) and interval (must be positive) 

or number of points. The points are calculated after pressing 

Calculate button. Obtained points can be saved to a file. 
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FIG.5.13. POSITIONING POINTS GENERATION WINDOW 

 

Configuration of Positioning measurement  

 

In the panel Positioning of the Config window the user can 

set up important options of the linear positioning measurements 

(Fig. 5.14). There are three available ways of checking machine’s 

positioning: Linear, Pilgrim1 and Pilgrim 2 (buttons in Measurement 

method panel). The directions of the expected movement of the 

machine are shown on the pictograms and on figures 5.15, 5.16 and 

5.17. Usually the Linear method is used.  
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FIG.5.14 LINEAR POSITIONING COFIG WINDOW 

 

In the Cycles in series edit the user can set how many complete 

measurements cycles are to be performed. The more cycles is chosen 

the better results will be achieved. 
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FIG.5.15. MACHINE MOVEMENT IN THE LINEAR MODE (S – STARTING 

POINT) 

 

 

FIG.5.16. MACHINE MOVEMENT IN THE PENDULUM MODE (S – 

STARTING POINT) 
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FIG.5.17. MACHINE MOVEMENT IN THE PILGRIM MODE (S – STARTING 

POINT) 

 

Max Acceptable Error is an option where the user can set the 

maximal acceptable error level above which the software will 

communicate to the user about a machine error. 

Options Point capture after and Vibrations are valid only when 

the automatic point capture is chosen. By changing these options the 

user can decide after how much time an automatic point capture 

trial should be made by the program and what is the acceptable 

level of vibration (level of vibration depends mainly on the 

measured machine). 

Min Points Interval describes minimal distance between 

positioning points. 
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Pull down menu - Measurement 

 

FIG.5.18. POSITIONING PULL-DOWN MENU MEASUREMENT  

 

Option Measurement includes the options connected with the 

process of measurement:  

Stop after each cycle – if this option is active program breaks 

the measurement after realization of a measuring cycle; if it is not 

active the configured number of cycles is executed.  

Correct target value – setting this option gives possibility to 

change an earlier defined distance value of a measuring point 

during the measurement process. Before point capture appears a 

window in which can be written new distance value whereupon 

marked are only places after comma what causes that it is not 

necessary to write all distances.  

Automatic point capture – program captures measurement 

points automatically using settings from Configuration. Option 

exclusive with “Manual point capture”. 

 

Manual point capture – choosing this option causes that for 

measuring points the measured displacement value is registered by 
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the program after pressing a button Manual Capture or a pulse 

switcher Strobe. If this option is not active than points are captured 

automatically (program detects the moment of machine stop).  

Automatic points generate – this option is marked when the 

positioning points are calculated automatically by the program and 

not chosen by the user (see below). Option exclusive with “Points 

from list”. 

Points from list – after choosing this option on the screen 

appears a window for edition measuring points in which we write 

or count distance value for positioning points. If this option is not 

active then the positioning points are marked automatically in first 

measuring cycle and the option Automatic Points List Generation 

is marked (see also figure 5.13).  

 

 

FIG.5.19. POSITIONING PULL-DOWN MENU VIEW  

 

Option View serves to switching on or off a panel Target 

value, Deviation table and to switching on drawing on the graph of 

measuring points from All cycles (active cycle is drawn using solid 

line but remaining cycles are illustrated using only points).  
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Measurement procedure 

 

If the system is ready to work, then two digital displays and 

the gauge of measuring signal level appear on the screen. On the 

upper display the measured value is shown. On the bottom display 

the value of the target position, read from data points table or 

appointed automatically, is shown. Under the displays on the left 

side there is shown a graph on which the results of measurements 

are shown. On the right side an Error Table can be found. Under the 

graph three buttons can be found: Start - beginning of the 

measurement, Reset Position – resetting the measured value and 

the button Main Menu - allowing to re-enter the Main menu. 

 

 

 

FIG.5.20 CHOICE BETWEEN 1D AND 3D POSITIONING 
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In the right upper corner of the main positioning window (see 

figure 5.20) there is placed the button for choosing if the laser is to 

measure only the positioning (“1D”) or if the 3D axes straightness is 

to be measured simultaneously (“3D”). If the “3D” option is chosen 

than, together with positioning data, the straightness data in 

horizontal and vertical plane are gathered. All measured data can be 

browsed during measurements by changing data panels (figure 

5.21). 

 

 

FIG.5.21. 3D DATA BROWSING  

 

In the bottom parts of the window a status bar can be found, 

on which there is presented a configuration of the positioning 

measurements. In the first field the information about the method of 

measuring points capture is placed (manual, automatic). In the 

second field there is shown the information whether measuring 

points originate from list or are marked automatically. The next field 

informs about number of cycles in series (number of cycles executed 

one after one, if not active is the option Stop After Cycle). 

To execute the linear positioning measurement, the program 

has to know the target position in which it has to make 
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measurement and where it has to calculate deviation from an 

expected value. The positioning points can be automatically defined 

in the first measuring cycle on a condition that distances between 

points are marked with an accuracy of 1.000mm. The positioning 

points can be also written or calculated after marking an option 

Target Points From List. After activating this option the positioning 

points can be defined in any accuracy.  

 

Measurement can be done in an Automatic option or in a 

Manual Capture option as described earlier in this chapter. In the 

automatic mode the system itself recognizes the moment of stop, the 

value of target point, the direction of movement and the series 

number.  

 

 

Rules of automatic positioning measurement  

 

For correct operation of the automatic option below rules 

should be followed:  

1) The time of machine stand still duration in a positioning 

point  must be no less then 1 second – default value (this can be 

changed in the Configuration->Max Accaptable Error),  

2) Vibrations of the target  should be less then 10 �m - default  

value (this can be changed in the Configuration->Vibrations less 

thans),   
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3) After every pass the target should be moved at least 2 mm 

away from the last positioning point, stopped until capture and, 

after it,  returned to the last positioning point  - this procedure is 

necessary for correct backslash error measurements.      

If vibrations are too large and system does not capture points – 

then the option Manual Capture should be switched on in the menu 

Measurement. After choosing the Manual Capture option on the 

bottom of the screen appears an additional button Manual Capture. 

Capture of the measuring point takes place by pressing this button 

or pressing the button on the impulse switcher.  

 

Course of measurements and data analysis 

 

Examination of linear positioning of machine consists of at 

least 2 measuring cycles. In every cycle the measured machine will 

move the retro-reflector for programmed distance fore (Avers) and 

back (Revers). After each shift the machine should stop for a time at 

least one second. The measured distance by the laser system is 

saved in the table of results. After one cycle, if Stop after each cycle 

is set or after the whole measurement process the window with 

results would appear (figure 5.22). 
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FIG.5.22. POSITIONING WINDOW AFTER FINISHING A FULL 

MEASUREMENT CYCLE  

 

Buttons Remove and Add can be used to remove or add the 

last measurement cycle. It is possible to change the measuring cycle 

in which accidental error is suspected. Button Browse opens data 

browsing window (figure 5.23) where each data cycle can be viewed 

and analyzed.  
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FIG.5.23. DATA BROWSING WINDOW  

 

Both from main positioning window and from data browsing 

window the measurement report can be generated. After at least 

two series of measuring cycles, statistical calculations can be 

executed and the report from examination can be prepared. In order 

to get the final report the button Report has to be pressed. The 

screen of the computer after pressing the button Report is presented 

on fig. 5.24. 
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FIG.5.24. LINEAR POSITIONING REPORT WINDOW 

 

The positioning parameters are presented on the graph. In the 

right side panel Results is found, on which the results of statistical 

calculations, the norm according to which calculations were 

executed and the limit values for the certain machine are presented. 

If the error value exceeds set limit for the machine this error is 

displayed in red. The norm can be chosen from a list. After choosing 

a new norm the results are recalculated.  

Under the graph there are: buttons used for change of the axis 

scale Axis Scale (automatic scaling or assignment, minimum and 

maximum values), choosing of parameters shown on the graph 

Parameters, report, printout Print and return to looking through the 

measuring cycles Previous Menu.  

Example of linear positioning report of CNC machine in axis is 

presented on the fig. 5.25.  
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FIG.5.25. LINEAR POSITIONING REPORT EXAMPLE 
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6  

MEASUREMENTS - VELOCITY 

 

 

 

 

 

 

General Description 

 

Velocity measurements are performed with the use of linear 

optics. This measurement can be used, for example, for 

characterization of motor movement.  The System allows for 

measuring velocity in different units, as can be chosen in 

Configuration->Velocity option. The value of velocity is sampled 

every 40ms. 

 

 

Measurement Setup 

 

For velocity measurements linear optics should be used. 

Necessary components are (see also figures 6.1 to 6.4): 

- Laser head  

-  Power supply  
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- Linear interferometer IL1 

- Linear retro-reflector RL1 

 

Optional elements are: 

- USB cable 

- Manual Strobe  

- Magnetic holder UM1 

- Tripod stand 

- Basis temperature sensor  

- Air temperature sensor 

 

Velocity measurements require optical elements IL1 and RL1 to 

be aligned along laser beam as shown on the figure 6.1. Either of the 

elements can be moved.  

During velocity measurements the usage of the air temperature 

sensor is recommended. Base temperature sensors do not have to be 

used. 

 

 FIG.6.1 OPTICAL PATH SET UP FOR VELOCITY MEASUREMENTS- 

SCHEMATIC 

 

Velocity measurements can be performed not only along the 

laser beam (as shown on figures 6.1 and 6.2) but also in directions 
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perpendicular to the laser beam. These configurations are shown on 

figures 6.3 and 6.4. In those two configurations only the retro-

reflector RL1 can be moved. 

 

 

FIG.6.2 OPTICAL PATH  SET UP FOR VELOCITY MEASUREMENTS IN X 

AXIS 
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FIG.6.3. OPTICAL PATH  SET UP FOR VELOCITY MEASUREMENTS IN Y 

AXIS 

 

FIG.6.4. OPTICAL PATH  SET UP FOR VELOCITY MEASUREMENTS IN Z 

AXIS 
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Software description 

 

Velocity is measured in the Velocity option, chosen from the 

Main Menu. The µLINE F1 program window should look like it is 

shown on the Fig. 6.5. The window consists of four main parts:  

- Display showing current velocity and measurement signal 

level; 

- Velocity plot; blue line is a plot of the measured velocity, 

red line is a plot of the mean velocity; 

- Velocity value table – combinations of time and measured 

velocity value are placed in this table; 

- Panel with buttons 
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FIG.6.5. VELOCITY MEASUREMENT WINDOW 

 

When the measurements are to be started the button Start 

should be pressed and the object, which displacement velocity is 

investigated, should be moved. To finish the velocity measurements 

the button Stop should be pressed. During measurements on the 

screen the velocity graph will be constantly updated. By clicking on 

a part of the graph and moving the mouse rightwards the graph can 

be zoomed. By clicking on a part of the graph and moving mouse 

leftwards the zoom is cancelled. The graph can be printed or saved 

to a file. This can be done by choosing from the upper menu File, 

and then suitable a option (i.e. Save, Save as, Print – see figure 6.6).  



MEASUREMENTS - VELOCITY 

6-7  www.statuspro.com    

 

FIG.6.6. VELOCITY  PULL-DOWN MENU FILE  

 

Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit->Machine 

data), like machine type, machine serial number, measured axis or 

machine operator (see figure 6.7). Entering those values allows 

describing performed measurement for later analysis. Those values 

are also present on the printed report. 
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FIG.6.7. MACHINE DATA WINDOW  

 

Measured data can not only be saved but also a measurement 

report can be generated, either by pressing Print or Preview on the 

measurement analysis window (fig. 6.8). The report can be 

generated either in the basic form where only the plot of the 

measured values is shown (fig. 6.9) or the extended version, in 

which also tables with measured data a present. 
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FIG.6.8. VELOCITY MEASURED DATA ANALYSIS WINDOW  

 

 

FIG.6.9. VELOCITY REPORT PREVIEW WINDOW  

 

Program makes it possible to save the velocity graph and then 

load it for example to a Word editor. To save graph to the file one 
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should click with the right mouse key within the area of the graph. 

From the popup menu that will appear the Copy to clipboard 

option should be chosen. 

The choice of the speed unit is also possible: from menu Edit 

we should choose option Config, where the velocity unit can be set. 

(see figure 6.10) 

 

FIG.6.10. VELOCITY CONFIGURATION OPTIONS  

 

 

Measurement procedure 

 

1. Set up the laser on the measured machine and align optical 

path 
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2. Start the µLINE F1 software option Velocity 

3. (optional) Choose the desired Velocity Unit in the 

Configuration window 

4. Press Start button and run the machine 

5. When the machine stops, press Stop button, save the results 

and/or print the measurement report. 
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7  

MEASUREMENTS - STRAIGHTNESS 

 

 

 

 

General Description 

 

Straightness measurements is a popular measurement usually 

used to gain basic information about a machine axis geometry. With 

this measuring option a user can either measure machine base 

straightness on all important surfaces of the base or check the 

movement of e.g. movement of a measured machine’s element in 

space. 

In the µLINE F1 device the straightness measurements can be 

performed with two different methods: Angular and Wollaston. 

Angular method is designed to be used in base straightness 

measurements (like optical autocollimator); Wollaston method is 

designed for “movement in space” measurements – e.g. the 

movement of a machine table or working tool can be characterized. 

The main parameters of those methods are described in the last 

Chapter. 
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Measurement Setup 

 

Angular straightness  measurement  

 

For Angular straightness measurements the angular optics 

should be used. Necessary components are: 

- Laser head  

- Power supply  

- Angular interferometer IK1 

- Angular retro-reflector RK1 

 

Optional elements are: 

- USB cable 

- Manual Strobe  

- Magnetic holder UM1 

- Tripod stand 

- Air temperature sensor  

- Base temperature sensor  

 

Angular straightness measurements require optical elements 

IK1 and RK1 to be aligned along laser beam as shown on the figure 

6.1. Either of the elements can be moved.  
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During Angular straightness measurements the usage of the air 

temperature sensor is recommended. Base temperature sensors do 

not have to be used. 

 FIG.7.1 OPTICAL PATH  SET UP FOR ANGULAR STRAIGHTNESS 

MEASUREMENTS- SCHEMATIC 

 

Angular straightness measurements can be performed not only 

along the laser beam (as shown on figures 7.1 and 7.2) but also in 

directions perpendicular to the laser beam. These configurations are 

shown on figures 7.3 and 7.4. In those two configurations only the 

retro-reflector RK1 can be moved. 
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FIG.7.2 OPTICAL PATH  SET UP FOR ANGULAR STRAIGHTNESS 

MEASUREMENTS IN X AXIS 

 

FIG.7.3 OPTICAL PATH  SET UP FOR ANGULAR STRAIGHTNESS 

MEASUREMENTS IN Y AXIS 

 

 

FIG.7.4 OPTICAL PATH  SET UP FOR ANGULAR STRAIGHTNESS 

MEASUREMENTS IN Z AXIS 
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Wollaston straightness  measurement  

 

For Wollaston straightness measurements the Wollaston optics 

should be used. Necessary components are: 

- Laser head  

- Power supply  

- Wollaston prism WP2-3 or WP2-10 

- Wollaston retro-reflector WRP1 

 

Optional elements are: 

- USB cable 

- Manual Strobe  

- Magnetic holder UM1 

- Tripod stand 

- Air temperature sensor  

- Base temperature sensor  

 

Wollaston straightness measurements require optical elements 

WP2-3 or WP2-10 (depending on required measurement range) and 

WRP1 to be aligned along laser beam as shown on the figure 7.5. 

Either of the elements can be moved.  

During Wollaston straightness measurements the usage of the 

air temperature sensor is recommended. Base temperature sensors 

do not have to be used. 
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 FIG.7.5 OPTICAL PATH  SET UP FOR WOLLASTONE STRAIGHTNESS 

MEASUREMENTS- SCHEMATIC 

 

 

FIG.7.6 OPTICAL PATH  SET UP FOR WOLLASTONE STRAIGHTNESS 

MEASUREMENTS IN X AXIS 

 

Wollaston straightness measurements can be performed in two 

configurations – horizontal X (figure 7.6) and vertical Z (figure 7.7). 

In configuration X only the straightness of path in X axis is 

measured. The same situation is with Z setup. 
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FIG.7.7 OPTICAL PATH  SET UP FOR WOLLASTONE STRAIGHTNESS 

MEASUREMENTS IN Z AXIS 

 

Software description 

 

All kind of straightness are measured in the Straightness 

option, chosen from the Main Menu. The µLINE F1 program 

window should look like it is shown on the Fig. 7.12. The window 

consists of four main parts:  

- Display showing current distance and measurement signal 

level; 

- Straightness plot; in 3D mode there visible plots for vertical 

and horizontal axis, in Angular and Wollaston mode only 

one plot is visible; 
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- Straightness value table – combinations of time and 

measured straightness value (or two values in 3D mode) 

are placed in this table; 

- Panel with buttons 

 

In the upper right corner a button for changing measurement 

mode is placed (fig. 7.12). There are four options available: Angular, 

Wollaston, 3D and Pitch/Yaw. The last mode is described in another 

Chapter of this document. 

        

 

FIG.7.12. STRAIGHTNESS MEASUREMENT WINDOW 

 

When the measurements are to be started the button Start 

should be pressed and the object, which straightness is investigated, 

should be moved. To finish the straightness measurements the 

button Stop should be pressed. During measurements on the screen 
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the straightness graph will be constantly updated. By clicking on a 

part of the graph and moving the mouse rightwards the graph can 

be zoomed. By clicking on a part of the graph and moving mouse 

leftwards the zoom is cancelled.  

 

Straightness  pull-down menus  

 

Viewed graph can be printed or saved to a file. This can be 

done by choosing from the upper menu File, and then suitable a 

option (i.e. Save, Save as, Print – see figure 7.13).  

 

FIG.7.13. STRAIGHTNESS  PULL-DOWN MENU FILE  

 

Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit->Machine 

data), like machine type, machine serial number, measured axis or 

machine operator. Entering those values allows describing 

performed measurement for later analysis. Those values are also 

present on the printed report. 
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FIG.7.13. STRAIGHTNESS  PULL-DOWN MENU EDIT 

 

Other options available in menu Edit are: 

- Measurement table – raw data are shown for analysis, 

export and print; 

- Base length – angular retroreflectror RK1 base length can 

be set (default is 100mm); option available also in 

Configuration->Parameters; 

- Squareness – squareness calculation as described later in 

this Chapter. 

- Configuration – opens Configuration window as shown 

on figure 7.14. 
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FIG. 7.14. STREIGHTNESS CONFIGURATION OPTIONS  

Reports 

 

Measured data can not only be saved but also a measurement 

report can be generated, either by pressing Print or Preview on the 

measurement analysis window (fig. 7.15). The report can be 

generated either in the basic form where only the plot of the 

measured values is shown (fig. 7.16) or the extended version, in 

which also tables with measured data a present. 
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FIG.7.15. STREIGHTNESS MEASURED DATA ANALYSIS WINDOW  

 

 

FIG.7.16. STREIGHTNESS REPORT PREVIEW WINDOW  

 

Program makes it possible to save the velocity graph and then 

load it for example to a Word editor. To save graph to the file one 
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should click with the right mouse key within the area of the graph. 

From the popup menu that will appear the Copy to clipboard 

option should be chosen. 
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Angular straightness measurements procedure 

 

The straightness measurements are driven along a straight line 

to which side surface of the angular retro-reflector base is tangent. 

In order to get the correct measurement the straight ruler, along 

which retro-reflector base will be pushed, should be fasten on a 

measured axis. In every moment of the measurement side surface of 

the retro-reflector base should be tangent to the ruler (see fig. 7.17). 

 

 

FIG.7.17. AN EXAMPLE OF OPTICAL COMPONENTS SETUP IN ANGULAR 

STRAIGHTNESS MEASUREMENT 

 

The Straightness measurement is based on pushing angular 

retro-reflector about an interval 100 mm and measuring its angle 

deviation. Before beginning to the measurement, measuring points 
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should be marked every 100 mm distance on the leading ruler or on 

the examined surface. It is recommended using ruler with scale.  

 

        

The measurement can be done in an automatic mode 

(standard arrangement) or in a manual mode with manual 

capturing of measuring points.  

In the automatic mode capturing of the measuring points takes 

place when a temporary time interval runs out. The time between 

capturing the measuring points is used to move the retro-reflector 

about a distance of 100 mm. The time interval should be used in 

dependence from practices of a person leading the measurements. It 

is suggested to set the time on 10 s and to decrease it if needed. An 

arrangement of the time interval may be done by pressing ← , →  

keys on the computer screen . The retro-reflector base P100 should 

be placed at the beginning of the examined axis close to the 

interferometer. After the Start button is pressed one should wait on 

capturing the first measuring point. Then one should to move the 

retro-reflector base of about 100 mm and to wait on the next point 

capture. Announcements shown on the computer screen make the 

measurement easy. After capturing the last measuring point press 

Stop.  

If from some reasons will not be possible to move the retro-

reflector base before the capture moment, the measurement should 

be repeated from the beginning point and possibly the measuring 

interval should be enlarged. 
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FIG.7.18. A RESULT OF STREIGHTNESS MEASUREMENT 

 

To make the measurement in the manual capture of the 

measuring points, the Measurement automatic in panel 

Measurement should be switched off. The measurement begins by 

pressing Start. The Capture of the measuring points can be done 

from the computer keyboard or by pressing the remote Strobe 

button. Each time after the movement of the retro-reflector base of 

about 100 mm, measuring point should be captured. After capturing 

the last point Stop should be pressed. 
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 The results of the measurements may be saved to a file or 

printed as described earlier. 
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Squareness measurements procedure 

 

 

FIG.7.21. SQUARENESS MEASUREMENT RESULTS 

 

Procedure of measuring the squareness of the machine’s axes: 

a. Set up the laser head at a certain position; 

b. Measure the straightness of the movement in the first 

axis according the previous described procedure. 

Straightness can be measured with the Wollastone or 

the 3D method. 

c. Store obtained results. 
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d. Measure the straightness of the movement in the 

second axis according the previous described 

procedure. Use the optical square etalon. Do not 

move the laser head!!! Any shift of the laser head 

position requires restarting the procedure from point 

1). 

e. Store obtained results. 

f. Choose Edit->Squareness option. The window like 

the one shown on the Fig 7.21. 

g. Load stored results and choose the squareness of 

which axes is of interest (i.e. Horizontal or Vertical). 

h. Calculated angle is shown in the bottom part of the 

window. 
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8  

MEASUREMENTS - FLATNESS 

 

 

 

 

General Description 

 

The flatness measurement is done on the basis of angular 

straightness measurements. In order to obtain a measured table 

flatness the measurement of angular straightness in eight axes is 

necessary. From obtained data a flatness map is drown (fig.8.1.). 

 

Measurement Setup 

 

For flatness measurements the angular optics plus additional 

mirrors should be used. Necessary components are: 

- Laser head  

- Power supply  

- Angular interferometer IK1 

- Angular retro-reflector RK1 

- Two Beam Benders BB2 (see figure 8.2) 
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FIG.8.1. AN EXEMPLARY SURFACE FLATNESS MAP 

 

Optional elements are: 

- USB cable 

- Manual Strobe  

- Magnetic holder UM1 

- Tripod stand 

- Air temperature sensor  

- Base temperature sensor  
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FIG.8.2. THE ELEMENT SET FOR THE FLATNESS MEASUREMENTS (IK1, 

RK1 ON P100 BASE AND BB2) 

 

Flatness measurements require, during measurements of first 

axis, that  optical elements IK1 and RK1 are aligned along laser 

beam as shown on the figure 8.3 Element IK1 is stationary and 

element RK1 is moved. Other axes are measured with the use of one 

or two beam benders, like shown on the figure 8.4. 

 FIG.8.3 OPTICAL PATH  SET UP FOR FLATNESS MEASUREMENTS - 

SCHEMATIC 
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During flatness measurements the usage of the SM1 

(Environmental Compensation Unit) is recommended. Base 

temperature sensors do not have to be used. 

FIG.8.4. OPTICAL PATH  SET UP FOR FLATNESS MEASUREMENTS IN ONE 

OF AXES 
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Alignment of optics for the flatness measurements 

 

The measurement of flatness consists of the measurements of 

deviations from straightness made along 8 axes. The measurement 

axes are set (in panel– Measurement->New Axis ) on a measured 

surface as shown on figure 8.5. On this figure are shown also: 

directions of measurements in the axes and margins that must be 

kept during measurements. 

 

 

FIG.8.5. THE MEASUREMENT AXES 

 

The measurements of deviations from straightness are made 

with angular optics as described in the Chapter Measurements - 
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Straightness. Depending on the measurement axis, a different set of 

optical components is used and the alignment of the optical path is 

done in slightly different way. All flatness measurements are done 

with one laser head position, shown on Figure 8.5.  

The flatness measurements are performed in the option 

Flatness. chosen from the Main Menu. After setting proper base 

length (standard is 100mm) and machine data (Edit->Machine Data 

and Edit->Base Length), the Measurement button should be pressed. 

Than a measured axis should be chosen (fig. 8.5) and than the 

optical path should be adjusted (see below). After the straightness of 

a chosen axis is measured a next axis should be chosen – 

Measurement->New Axis (fig. 8.6) When all the axes are measured, 

Flatness Plot button should be pressed. The received flatness plot 

(fig. 8.1) may be saved, printed or exported to a text file (File->Save, 

File->Print or File->Export). 
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FIG.8.6. CHANGING AXIS IN FLATNESS MEASUREMENT 

 

Optical path alignment in the axis “1”. 

The straightness measurement in the axis “1” is done with the 

optical components and in the way described in Chapter 7, 

Straightness measurements. 

 

 

Optical path alignment in the axes: “3”, “6”, “8”. 

 

During flatness measurements in the axes “3”, “6” and “8” an 

additional beam directing mirror ZK1 is used. The way of using it is 

shown on Figure 8.7. 
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FIG.8.7. THE SET OF THE OPTICAL COMPONENTS USED IN 

STRAIGHTNESS MEASUREMENTS IN THE AXES: “3”, “6:” AND “8” 

 

 

1. The diaphragm on the laser head set to the Alignment 

position, 

2. The beam directing mirror ZK1 set 45o to the laser beam 

coming out from the head, 

3. Place the angle interferometer IK1 in the measured axis, 

4. Set the diaphragm on the angle interferometer to the 

Alignment position, 

5. Change the position of the head so that the beam falls in the 

middle of upper interferometer’s diaphragm, 
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6. Set the diaphragm on the angle retro-reflector to the 

Alignment position 

7. Moving the retro-reflector along the axis, change the 

position of the head so that the beam passing through the 

interferometer falls also in the middle of the retro-reflector’s 

diaphragm, 

8. After changing the positions of the diaphragms on the 

interferometer and on the retro-reflector to Working 

positions, check if the return beam falls in the middle of 

measuring opening in the head. Do the check moving the 

retro-reflector along the axis. Corrections, if needed, can be 

made both changing the head or the interferometer 

position, 

9. Set the diaphragm on the laser head to Working position 

and check if the level indicator on the display shows 

around 100%, 

10. Now the straightness measurements, as described in 

Chapter 7, can be made. 

 

 

Optical path alignment in the axes: “5” and “7” 

 

During flatness measurements in the axes “5” and “7” two 

beam directing mirrors ZK1 are used. The way of using them is 

shown on Figure 8.8. 
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FIG.8.8. THE SET OF THE OPTICAL COMPONENTS USED IN 

STRAIGHTNESS  

MEASUREMENTS IN THE AXES: “5” AND “7” 

 

 

1. The diaphragm on the laser head set to the Alignment 

position, 

2. The first beam-directing mirror ZK1 set 45o to the laser 

beam coming out from the head. The position of the laser 

head should be regulated in a way that the beam reflected 

from the first mirror runs parallel to the axis “3” and falls 
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on the second beam-directing mirror. The second mirror is 

set 45o to the first one, 

3. Changing the position and the angle of the second mirror 

direct the reflected beam along the axes “5” or “7” in a way 

the beam is parallel to the axis, 

4. Place the angle interferometer in magnetic holder of the 

second mirror and set it in the optical path, 

5. Set the diaphragm on the angle interferometer to the 

Alignment position, 

6. Change the position of the head so that the beam falls in the 

middle of upper interferometer’s diaphragm, 

7. Set the diaphragm on the angle retro-reflector to the 

Alignment position, 

8. Moving the retro-reflector along the axis, change the 

position of the head so that the beam passing through the 

interferometer falls also in the middle of the retro-reflector’s 

diaphragm, 

9. After changing the positions of the diaphragms on the 

interferometer and on the retro-reflector to Working 

positions, check if the return beam falls in the middle of 

measuring opening in the head. Do the check moving the 

retro-reflector along the axis. Corrections, if needed, can be 

made both changing the head or the interferometer 

position, 
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10. Set the diaphragm on the laser head to Working position 

and check if the level indicator on the display shows 

around 100%, 

11. Now the straightness measurements, as described in 

Chapter 7, can be made. 

 

Optical path alignment in the axes: “2” and “4” 

 

Similar to previously described, during flatness measurements 

in the axes “2” and “4” two beam directing mirrors ZK1 are used. 

The difference is that the angle of the second mirror usually differs 

from 45o. The way of using them is shown on Figure 8.9. 
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FIG.8.9. THE SET OF THE OPTICAL COMPONENTS USED IN 

STRAIGHTNESS MEASUREMENTS IN THE AXES: “2” AND “4” 

 

2. The diaphragm on the laser head set to the Alignment 

position, 

3. The first beam-directing mirror ZK1 set 45o to the laser 

beam coming out from the head. The position of the laser 

head should be regulated in a way that the beam reflected 

from the first mirror runs parallel to the axis “3” and falls 

on the second beam-directing mirror. The second mirror is 

set in the necessary angular  to the first one, 
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4. Changing the position and the angle of the second mirror 

direct the reflected beam along the axis “4” in a way the 

beam is parallel to the axis, 

5. Place the angle interferometer in magnetic holder of the 

second mirror and set it in the optical path, 

6. Set the diaphragm on the angle interferometer to the 

Alignment position, 

7. Change the position of the head so that the beam falls in the 

middle of upper interferometer’s diaphragm, 

8. Set the diaphragm on the angle retro-reflector to the 

Alignment position, 

9. Moving the retro-reflector along the axis, change the 

position of the head so that the beam passing through the 

interferometer falls also in the middle of the retro-reflector’s 

diaphragm, 

10. After changing the positions of the diaphragms on the 

interferometer and on the retro-reflector to Working 

positions, check if the return beam falls in the middle of 

measuring opening in the head. Do the check moving the 

retro-reflector along the axis. Corrections, if needed, can be 

made both changing the head or the interferometer 

position, 

11. Set the diaphragm on the laser head to Working position 

and check if the level indicator on the display shows 

around 100%, 
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12. Now the straightness measurements, as described in 

Chapter 6, can be made. 

 

In the case of the measurements in the axis “2”, the path 

alignment procedure is the same as described above. The only 

difference is that the second mirror, as not needed, is not used. 

 





MEASUREMENTS – PITCH/YAW 

9-1  www.statuspro.com    

 

9  

  MEASUREMENTS – PITCH/YAW 

 

 

 

 

General Description 

 

Measurements of Pitch/Yaw are designed to give information 

about a machine axis geometry. With this measuring option a user 

can either measure machine base straightness on all important 

surfaces of the base or check the quality of movement of a measured 

element. The measured errors are known in the literature as pitch 

and yaw errors. Pitch/Yaw option is very similar to the Angular 

Straightness option as described in another Chapter of this 

document. Those two measurements differ only by different 

methods of calculation of end results. 

  

Measurement Setup 

 

For Pitch/Yaw measurements the angular optics should be 

used. Necessary components are: 

- Laser head  
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- Power supply 

- Angular interferometer IK1 

- Angular retro-reflector RK1 

 

Optional elements are: 

- USB cable 

- Manual Strobe  

- Magnetic holder UM1 

- Tripod stand 

- Air temperature sensor  

- Base temperature sensor  

 

Pitch/Yaw measurements require optical elements IK1 and 

RK1 to be aligned along laser beam as shown on the figure 9.1. 

Either of the elements can be moved.  

During Pitch/Yaw measurements the usage of the SM1 

(Environmental Compensation Unit) is recommended. Base 

temperature sensors do not have to be used. 

 FIG.9.1 OPTICAL PATH  SET UP FOR PITCH/YAW MEASUREMENTS- 

SCHEMATIC 
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Pitch/Yaw measurements can be performed not only along the 

laser beam (as shown on figures 9.1 and 9.2) but also in directions 

perpendicular to the laser beam. These configurations are shown on 

figures 9.3 and 9.4. In those two configurations only the retro-

reflector RK1 can be moved. 

 

FIG.9.2 OPTICAL PATH  SET UP FOR PITCH/YAW MEASUREMENTS IN X 

AXIS 
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FIG.9.3 OPTICAL PATH  SET UP FOR PITCH/YAW MEASUREMENTS IN Y 

AXIS 

 

 

FIG.9.4 OPTICAL PATH  SET UP FOR PITCH/YAW MEASUREMENTS IN Z 

AXIS 

 



MEASUREMENTS – PITCH/YAW 

9-5  www.statuspro.com    

Software description 

 

Pitch and Yaw errors can be measured in the Pitch/Yaw option, 

chosen from the Main Menu. The µLINE F1 program window 

should look like it is shown on the Fig. 9.5. The window consists of 

four main parts:  

- Display showing recent measured angle and measurement 

signal level; 

- Obtained results plotted on a graph; 

- Obtained results displayed in the measurement table 

- Panel with buttons 

        

 

FIG.9.5. PITCH/YAW MEASUREMENT WINDOW 
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Before starting the measurements the right point capture 

method from the Measurement menu should be chosen (see figure 

10.6). There are two methods available: 

- Time period point capture – points are captured 

automatically after the time set on the panel with buttons 

- Manual point capture – points are captured after the user 

presses Point capture button on the panel with buttons or 

presses Manual Strobe button 

 

 

FIG.9.6. PITCH/YAW PULL-DOWN MENU MEASUREMENT 

 

When the measurements are to be started the button Start 

should be pressed. Depending on the chosen point capture method 

the points will be captured automatically or must be captured by the 

user. To finish the measurements the Stop button should be pressed. 

During measurements the graph on the screen will be constantly 

updated.  

 



MEASUREMENTS – PITCH/YAW 

9-7  www.statuspro.com    

FIG.9.7. PITCH/YAW PULL-DOWN MENU FILE  

 

Obtained results can be saved, printed or exported (menu 

File). Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit->Machine 

data), like machine type, machine serial number, measured axis or 

machine operator (see figure 9.8). Entering those values allows 

describing performed measurement for later analysis. Those values 

are also present on the printed report. 

 

FIG.9.8. MACHINE DATA WINDOW  
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Measured data can not only be saved but also a measurement 

report can be generated, either by pressing Print or Preview on the 

measurement analysis window (fig. 9.9). The report can be 

generated either in the basic form where only the plot of the 

measured values is shown or the extended version, in which also 

tables with measured data are present. 

 

FIG.9.9. PITCH/YAW MEASURED DATA ANALYSIS WINDOW  

 

 

Program makes it possible to save the velocity graph and then 

load it for example to a Word editor. To save graph to the file one 

should click with the right mouse key within the area of the graph. 

From the popup menu that will appear the Copy to clipboard 

option should be chosen. 

Configuration options for Pitch/Yaw are available in the 

Configuration->Straightness window. The important option is the 
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choice of statistic calculation method (fig. 9.10) of end results. End 

point fit or Least squareness fit can be chosen. For the analysis of 

raw results the option None should be marked. 

 

 

FIG. 9.10. PITCH/YAW CONFIGURATION OPTIONS  

 

 

Measurement procedure 

 

1. Set up the laser on the measured machine and align optical 

path 

2. Start the µLINE F1 software option Pitch/Yaw 

3. Choose the desired point capture method 
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4. Press Start button and run the machine 

5. In the manual mode press the Strobe button; in the automatic 

mode observed the behavior of the software 

6. Stop the measurement 

7. Save the results and/or print the measurement report. 
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 MEASUREMENTS - VIBRATION 

 

 

 

 

 

General Description 

 

Vibration measurements are performed with the use of linear 

optics. This measurement can be used, for example, for 

characterization of motor movement. The laser measurement system 

µLINE F1 is capable of detecting machine vibrations in the 

frequency range from 0 to 500 Hz in Bluetooth mode and 0 to 50kHz 

in USB mode. The sensitivity in USB mode is also much higher – 

100pm compared to 10nm in Bluetooth mode. 

The System allows measuring velocity in different units in 

single shot and continuous mode. The parameters of the 

measurement can be set in the Configuration->Vibration option. 
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Measurement Setup 

 

For velocity measurements linear optics should be used. 

Necessary components are (see also figures 10.1 to 10.4): 

- Laser head 

-  Power supply 

- Linear interferometer IL1 

- Linear retro-reflector RL1 

 

 

Optional elements are: 

- USB cable 

- Manual Strobe  

- Magnetic holder UM1 

- Tripod stand 

- Basis temperature sensor  

- Air temperature sensor  

 

Vibration measurements require optical elements IL1 and RL1 

to be aligned along laser beam as shown on the figure 10.1. The laser 

measures the difference of vibrations of both optical elements (i.e. 

IL1 and RL1). 

During vibration measurements the usage of the air 

temperature sensor is recommended. Base temperature sensors do 

not have to be used. 
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 FIG.10.1 OPTICAL PATH SET UP FOR VIBRATION MEASUREMENTS- 

SCHEMATIC 

 

Vibration measurements can be performed not only along the 

laser beam (as shown on figures 10.1 and 10.2) but also in directions 

perpendicular to the laser beam. These configurations are shown on 

figures 10.3 and 10.4. In those two configurations only the retro-

reflector RL1 can be moved. 

 

 

FIG.10.2 OPTICAL PATH  SET UP FOR VIBRATION MEASUREMENTS IN X 

AXIS 
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FIG.10.3. OPTICAL PATH  SET UP FOR VIBRATION MEASUREMENTS IN Y 

AXIS 

 

FIG.10.4. OPTICAL PATH  SET UP FOR VIBRATION MEASUREMENTS IN Z 

AXIS 
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Software description 

 

Vibrations are measured in the Vibration option, chosen from 

the Main Menu. The µLINE F1 program window should look like it 

is shown on the Fig. 10.5. The window consists of four main parts:  

- Display showing measurement signal level and percent of 

samples gathered; 

- Two plots – upper showing gathered distance, velocity or 

acceleration data, lower the Fourier Transformation (FFT) 

of the upper plot; 

- Options of measurements 

- Panel with buttons 

        

 

FIG.10.5. VIBRATION MEASUREMENT WINDOW 
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Before starting the measurements the options in the right 

panel should be set according to requirements. When the 

measurements are to be started the button Start should be pressed. 

When Continuous option is checked then the measurement has to be 

finished by pressing the Stop button. During measurements on the 

screen the graphs will be constantly updated.  

When both the measurement and the transmission are done, 

the measurement results are presented on the time diagram and its 

FFT analysis on the frequency diagram (fig.10.8). The results can be 

saved, printed or exported (menu File). With the use of radio 

buttons the type of input data may be chosen, i.e. whether 

amplitude of Distance, Velocity or Acceleration is important. The 

check radio buttons in the bottom right of the window allow to 

change the vertical scale of the frequency diagram to logarithmic 

and to eliminate a DC offset. 

 

 

FIG.10.6. VIBRATION  PULL-DOWN MENU FILE  

 

Before saving the file the program asks about changing 

machine data (option available from pull-down menu Edit->Machine 
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data), like machine type, machine serial number, measured axis or 

machine operator (see figure 10.7). Entering those values allows 

describing performed measurement for later analysis. Those values 

are also present on the printed report. 

 

FIG.10.7. MACHINE DATA WINDOW  

 

Measured data can not only be saved but also a measurement 

report can be generated, either by pressing Print or Preview on the 

measurement analysis window (fig. 10.8). The report can be 

generated either in the basic form where only the plot of the 

measured values and calculated frequency transformation is shown 
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(fig. 10.9) or the extended version, in which also tables with 

measured data is present. 

 

FIG.10.8. VIBRATION MEASURED DATA ANALYSIS WINDOW  

 

 

FIG.10.9. VIBRATION REPORT PREVIEW WINDOW (PAGE 1)  
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Program makes it possible to save the velocity graph and then 

load it for example to a Word editor. To save graph to the file one 

should click with the right mouse key within the area of the graph. 

From the popup menu that will appear the Copy to clipboard 

option should be chosen. 

In the Configuration window for Vibration measurement the 

number of samples in single shot and continuous measurement can 

be set. The default folder for storing measurement data can also be 

set here. 

 

 

FIG. 10.10. VIBRATIONS CONFIGURATION OPTIONS  
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Measurement procedure 

 

8. Set up the laser on the measured machine and align optical 

path 

9. Start the µLINE F1 software option Vibration 

10. (optional) Choose the desired Vibration options 

11. Press Start button and run the machine 

12. In the continuous mode press Stop button; in the single-shot 

mode wait for the end of measurements 

13. Save the results and/or print the measurement report. 

 

To obtain correct results, a point of attaching the retro-reflector 

to the corpse of a measured machine must be carefully chosen. If the 

point is chosen improperly than, instead of a sought frequency f, a 

multiple frequencies n*f appear (where n=1,2,...) on the FFT chart. 

For that reason the retro-reflector must not be in these 

measurements used with the magnetic holder UM1. UM2 holder 

can be used instead. It must be also remembered that the system 

measures the vibration only in the axis of the optical path. Any 

vibrations in perpendicular axes do not influence the measurement 

(see fig.10.11). An example of a properly attached retro-reflector is 

shown on fig. 10.12. 
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Laser

Retroreflector

RL1

Interferometer

IL1

Retroreflector

RL1

Interferometer

IL1

Laser
Vibrations

important

Vibrations not

important

A)

B)

 FIG.10.11. VIBRATION MEASUREMENT IN DIFFERENT AXES 

                

FIG.10.12. EXAMPLE OF PROPERLY ATTACHED RETRO-REFLECTOR 
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TECHNICAL DATA 

 

 

 

 

System specifications 

 

 

Measurement Range Resolution Accuracy 

Distance 0 – 30 m 100 pm 0,4 µm/m 

Velocity 0 – 6 m/s 0.25 µm/s 0,1 % 

Angular 0 – 3600 arcsec 0,04 arcsec ± 0,2 % 

Straightness measurement 

(with angular optics) 

0 – 15 m 0,02 µm (for 100 mm 

base) 

± 1 % 

Flatness 

0 – 15 m 

Vertical range ±2 

mm 

0,02 µm (for 100 mm 

base) 

± 0,5 % 

Straightness measurement 

(with wollastone prism) 

0 – 3 m 0.5 µm 
± 1 %±(0.5±0.15L2) 

µm  

Squareness  ± 1000 arcsec 0,4arcsec ± 1 %  ± (1,5 arcsec) 

Rotary measurements ± 5 ° 0,04 arcsec ± 0,2 % 

L = axis length in meters 

* - for resolution 1 nm. 
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Laser head 

Laser type 
HeNe laser with frequency 

stabilization 

Heating time Approx. 5 min 

Wavelength (vacuum) 
632,990566 nm (H) 

632,992031 nm (V) 

Wavelength accuracy ± 0,005 ppm 

Short time stability ± 0,001 ppm (1 hour) 

Output power  800 µW 

Beam diameter 8 mm 

Distance between out- and ingoing 

beam 

12,7 mm 

Laser head dimensions 45x70x245 mm 

Net weight 1500 g 

Safety class 
Class 2 Laser product according to 

PN-91/T-06700 

 

Laser head outputs - analog 

Signal type SinA / CosB 

Voltage level 1 Vpp 

Signal resolution User defined: 

from 100nm/period to 5mm/period  

in 100nm/period step 

Maximal signal frequency 5 MHz 

 

Laser head outputs – digital, type 1 

Signal type A quad B 
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Voltage level 5 V differential CMOS 

Signal resolution User defined: 

from 100nm/period to 5mm/period  

in 100nm/period step 

Maximal signal frequency 5 MHz 

 

Laser head outputs – digital, type 2 

Signal type Shift / Sign 

Voltage level 5 V differential CMOS 

Signal resolution User defined: 

from 0.1nm/pulse to 5um/pulse  

in 0.1nm/pulse step 

Pulse width 5 ns 

Maximal signal frequency 100 MHz 

 

Laser head outputs – Extension connector pinout 

Connector type Hirose Connector LX40-20P 

CL No. CL245-0017-0 

 

Pin number Function 

1. 24V Supply 

2. Digital IO  Reserved for future use 

3. Digital IO  Reserved for future use 

4. Digital IO  Reserved for future use 

5. Digital IO  Reserved for future use 

6. Digital IO  Reserved for future use 

7. Digital IO  Reserved for future use 
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8. Digital IO  • Negative output of Differential B signal pair (Digital 

AquadB Output)  

• Negative output of Differential Sign signal pair 

(Shift/Sign Output) 

9. Digital IO  • Negative output of Differential A signal pair 

(Digital AquadB Output) 

• Negative output of Differential Module signal pair 

(Shift/Sign Output) 

10. Digital IO  • Positive output of Differential B signal pair (Digital 

AquadB Output) 

• Positive output of Differential Sign signal pair 

(Shift/Sign Output) 

11. Digital IO  • Positive output of Differential A signal pair (Digital 

AquadB Output) 

• Positive output of Differential Module signal pair 

(Shift/Sign Output) 

12. 5V Supply 

13. Analog Output  Negative output of Differential Cosine signal pair 

(Sine/Cosine Output) 

14. Analog Output  Negative output of Differential Sine signal pair 

(Sine/Cosine Output) 

15. Analog Output  Positive output of Differential Cosine signal pair 

(Sine/Cosine Output) 

16. Analog Output  Positive output of Differential Sine signal pair (Sine/Cosine 

Output) 

17. Ground 

18. Ground 

19. Ground 

20. Ground 
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System work conditions 

Temperature range 10 – 35 °C 

Humidity range 10 – 90 % (non-condensing) 

 

 

Power supply 

 

 

PC interface 

Type 1 USB 2.0 

Data rate 3125000 bps (VCOM) 

 

Type 2 Bluetooth 2.0 + EDR 

Connection  Point-to-Point (pico net) 

Frequency 2.400 to 2.4835 GHz 

Tx Power Max 18 dBm (Class 1) 

Rx Sensitivity -86 dBm typical 

Coverage Up to 25m 

 

Environment compensation 

   Wavelength compensation 

Manual Environments parameters entered 

from keyboard 

Voltage 90-230 VAC, 50-60 Hz 

Power 
100 W (during heating) 

15 W (work) 
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Automatic With the use of the Environmental 

Compensation Unit - (ECU) . 

 

Parameters of the wired Environmental Compensation Unit - (ECU) compensation 

Air temperature Range 0 – 40 °C, accuracy 0,1 °C 

Pressure Range 940 – 1060 hPa, accuracy 1 hPa 

Humidity Range 10 – 90 %, accuracy 10 % 

Time constants Temperature 3 s, pressure 2s, humidity 

20 s 

Dimension φ50x55 mm 

Net weight 100 g 

 

 

 Wired material temperature compensation 

Manual Temperature of material entered from 

keyboard 

Automatic With the use of 1 to 3 wired 

temperature sensors . 

Temperature sensor Pt-1000 in oil resistant casing. 

Time constant 5 s 

Net weight 50 g 

 

Parameters of the wireless Environmental Compensation Unit - (ECU) compensation 

Air temperature Range 0 – 40 °C, accuracy 0,1 °C 

Pressure Range 940 – 1060 hPa, accuracy 1 hPa 

Humidity Range 10 – 90 %, accuracy 10 % 

Time constants Temperature 8 s, pressure 2s, humidity 

20 s 

Dimension φ50x55 mm 
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Net weight 150 g 

 

 

 Wireless material temperature compensation 

Manual Temperature of material entered from 

keyboard 

Automatic With the use of 1 to 3 wireless 

temperature sensors . 

Temperature sensor Pt-1000 

Time constant 10 s 

Net weight 150 g 

 

 

Our products are subject to continuous further development and 

improvement. Subject to technical changes without prior notice. 


